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STL File Format
Description

What is an STL File?

. ond
4 not 0\'\9‘°p“Y fil

TL - Tessellation L
STL — Standard Tessellation Language r ithoar?

gTL o
This file format is widely used in rapid +
prototyping (i.e. 3D printing, additive manufacturing). It contains only a
single triangular mesh of an objects surface. Color, texture, materials, and
other attributes are not represented in the standard STL file format. Hacked

formats exists to accommodate this type of additional information.

They can be text files or binary. Binary is more common because they are
more compact. We will look at text files because that is more easily
interfaced with MATLAB.

S EMPossible
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Surface Mesh

Despite this sphere really being a solid object, it is represented in an STL file by just its

surface.

Solid Object

51 EMPossible

STL Representation
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solid name

facet normal n, n, n,

outer loop
vertex v, v, v,
vertex v, v, v.,
vertex v,; v, 3 v.3
endloop
endfacet

endsolid name

STL File Format

This set of text is repeated for every
triangle on the surface of the object. v

Bold face indicates a keyword; these must appear in lower case. Note that there is a space in “facet normal” and in “outer loop,” while there is no space in
any of the keywords beginning with “end.” Indentation must be with spaces; tabs are not allowed. The notation, “{...}+,” means that the contents of the

brace brackets can be repeated one or more times. Symbols in italics are variables which are to be replaced with user-specified values. The numerical data
in the facet normal and vertex lines are single precision floats, for example, 1.23456E+789. A facet normal coordinate may have a leading minus sign; a

vertex coordinate may not.

S EMPossible
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solid pyramid

outer loop
vertex 4.323172e-018
vertex 3.750000e-001
vertex 3.750000e-001
endloop
endfacet
facet normal 0.000000e+000
outer loop
vertex 7.500000e-001
vertex 3.750000e-001
vertex 0.000000e+000
endloop
endfacet
facet normal 8.281842e-001
outer loop
vertex 3.750000e-001
vertex 3.750000e-001
vertex 7.500000e-001
endloop
endfacet
facet normal 0.000000e+000
outer loop

endloop
endfacet
endsolid pyramid

S EMPossible
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2.

0.
.081604e-001 4.330127e-001
0.

2

Example STL File

facet normal -8.281842e-001 2.923717e-001 -4.781524e-001

.632799e-017 6.495190e-001
.081604e-001 4.330127e-001
0.

000000e+000 0.000000e+000

923717e-001 9.563048e-001

000000e+000 6.495190e-001

000000e+000 6.495190e-001

.923717e-001 -4.781524e-001

-1.632799e-017 0.000000e+000

7.
0.

081604e-001 4.330127e-001
000000e+000 6.495190e-001

-1.000000e+000 0.000000e+000

vertex 3.750000e-001 0.000000e+000 0.000000e+000
vertex 7.500000e-001 0.000000e+000 6.495190e-001
vertex 0.000000e+000 0.000000e+000 6.495190e-001

dnidals

An STL file is essentially just a list of all the
triangles on the surface of an object.

Each triangle is defined with a surface
normal and the position of the three
vertices.

Slide 7
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outer loop
endloop

endfacet

outward from object.

shading information.
b) Don’t depend on it/

polygons. Don’t do this.

S EMPossible

facet normal -8.281842e-001 2.923717e-001

A Single Triangle

vertex 4.323172e-018 1.632799e-017 6.495190e-001
vertex 3.750000e-001 7.081604e-001 4.330127e-001
vertex 3.750000e-001 0.000000e+000 0.000000e+000

1. Facet normal must follow right-hand rule and point

a) Some programs set this to [0;0;0] or convey

2. Adjacent triangles must have two common vertices.
3. STL files appear to be setup to handle arbitrary

-4.781524e-001

Vertex 3

Facet Normal

Vertex 1

Vertex 2

Slide 8
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Warnings About Facet Normals

* Since the facet normal can be calculated from the
vertices using the right-hand rule, sometimes the
facet normal in the STL file contains other information
like shading, color, etc.

* Don’t depend on the right-hand rule being followed.
* Basically, don’t depend on anything!

S EMPossible
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STL File
Problems and
Repairing
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Inverted Normals

All surface normals should point outwards.

Good Bad

http://admproductdesign.com/workshop/3d-printing/definition-of-stl-errors.html

5 EMPossible
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Intersecting Triangles

http://admproductdesign.com/workshop/3d-printing/definition-of-stl-errors.html

<) EMPossible

No faces should cut through each other. Intersections should be removed.
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Noise Shells

A shell is a collection of triangles that form a single independent object. Some STL files
may contain small shells that are just noise. These should be eliminated.

Main shell \
/Noise Shell

A

51 EMPossible 13
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Nonmanifold Meshes

A manifold (i.e. watertight) mesh has no holes and is described by a single continuous
surface.

Manifald Naon-Manifold Non-Manifald

http://http://www.autodesk.com/

S EMPossible 14
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Mesh Repair Software

e Commercial Software
* Magics

. NetFabb SO\)(CQ.\(\"

* SpaceClaim N

* Autodesk . (oo Soma‘e'
e “‘OA‘CP\O

* Open Source Alternatives
* MeshlLab ¢
* NetFabb Basic
* Blender
* Microsoft Model Repair

S EMPossible
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Importing and
Exporting STL
Files in MATLAB
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MATLAB Functions for STL Files

The Mathworks website has very good functions for reading and writing STL files in both
ASCII and binary formats.

STL File Reader
http://www.mathworks.com/matlabcentral/fileexchange/29906-binary-stl-file-reader

STL File Writer
http://www.mathworks.com/matlabcentral/fileexchange/36770-stlwrite-write-binary-or-
ascii-stl-file

S EMPossible 17
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How to Store the Data

There are N facets and < 3N vertices to store in arrays.

F (N, 3) Array of triangle facets
V(?,3) Array of triangle vertices

Many times, the number of vertices is 3N. Observing that many of the triangle facets share
vertices, there will be redundant vertices.

STL files can be compressed to eliminate redundant vertices, but many times they are not.

S EMPossible 18
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Lazy Array of Vertices (1 of 2)

5

vx,] vy,l v:,l
v V. A%
2 y.2 z,2
V =
vx M vy,M vz,M

V'is an array containing the
position of all the vertices in
Cartesian coordinates.

M is the total number of
vertices.

19

S EMPossible
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Lazy Array of Vertices (2 of 2)

There is redundancy here. Twelve vertices are stored, but the device is really only
composed of four.

While an inefficient representation,
this is probably not worth your time fixing.

SolidWorks exports a lazy array of vertices.

1,6,12

20
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Compact Array of Vertices

2

S
1

=

Ll vz,l
v

,2 12 z,2

=

o2 o2 vz,3

,‘< R<<! w:“‘ ‘<<

=
&
s
=
=

)
=

Array of Vertices, V'

S EMPossible
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Array of Faces

n, M, n, 5 all integers

Fis an array indicating the
array indices of the vertices
defining the facet.

N is the total number of
faces.

S EMPossible
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Example of Lazy Arrays

Fm
| 2 -
4 s 6
7 e el
10 12
V=
0.0000 0.6495 0.0000
0.3750  0.4330  0.7082
0.3750 0 0 49,11
0.7500 0.6495 0
0.3750 0.4330 0.7082
0 0.6495 0 1,6,12
0.3750 [} =0.0000
0.3750  0.4330  0.7082
0.7500 0.6495 0 3,7,10
0.3750 0 0
0.7500 0.6495 0
0 0.6495 0
S EMPossible 23
23
i 2 3
4 2 1
3 2 4
3 4 1
435 0000
4330 7082
o 1]
6495 ]
This can make a very large difference for large and complex objects.
S EMPossible 2
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Eliminating Redundant Vertices

Redundant vertices are easily eliminated using MATLAB’s built in unique () command.

Identifies unique rows in vV

and eliminates them from V.
ELIMINATE REDUNDENT VERTICES

[V,indm, indn] = unique(V, 'rows');
F

Z indn(F) Corrects indices in F that

referenced eliminated vertices.

indm—indices of rows in V that correspond to unique vertices.
indn — Map of row indices in original V to new row indices in the reduced V.

% ELIMINATE REDUNDENT VERTICES WITH TOLERANCE
[~,indm, indn] = unique (round(V,6), 'rows’) ; OnIy checks to 6
V = V(indm, :); digits of accuracy.
F = indn(F) ;
S EMPossible 25
25
For some reason, Solidworks does not use the z-axis as the vertical axis.
For convenience, STL files can be easily reoriented.
% REORIENT SOLIDWORKS AXES TO MATLAB AXES
Y = V(:,2);
V(:,2) = V(:,3); L
v(:,3) = Y;
~
Orientation in SolidWorks Imported Orientation Adjusted Orientation
ﬂ EMPossible 26
26
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Visualizing
Surface Meshes
in MATLAB

Slide 27

27
Given the faces and vertices, the object can be drawn in MATLAB using the patch ()
command.
% DRAW STRUCTURE USING PATCHES
P = patch('faces',F, 'vertices',V);
set (P, 'FaceColor', 'b', 'FaceAlpha',0.5) ; e ==
set (P, 'EdgeColor', 'k', 'LineWidth', 2) ; N5Qs b N20DEL-A/08 8
1 EMPossible 28
28
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Generating
Faces and

Vertices Using
MATLAB

29

MATLAB Surfaces

Surfaces composed of square facets are stored in X, Y, and Z arrays.

The surface shown is constructed
of arrays that are all 5x5.

X =
-1.0000 -0.6000 -0.2000 0.2000 0.6000
-1.0000 -0.6000 -0.2000 0.2000 0.6000
-1.0000 -0.6000 -0.2000 0.2000 0.6000
-1.0000 -0.6000 -0.2000 0.2000 0.6000
-1.0000 -0.6000 -0.2000 0.2000 0.6000
¥ = zZ =
-1.0000 -1.0000 -1.0000 -1.0000 -1.0000 0.1000 o 0.1000 0.2000 0.2000
-0.6000 -0.6000 -0.6000 =-0.6000 =-0.6000 0 o 0.1000 0.2000 0.2000
-0.2000 -0.2000 -0.2000 =-0.2000 =-0.2000 0 0.1000 0.1000 0.2000 0.1000
0.2000 0.2000 0.2000 0.2000 0.2000 0.1000 0.1000 0.1000 0.1000 0.1000
0.6000 0.6000 0.6000 0.6000 0.6000 0.1000 0.1000 o 0.1000 0.2000

S EMPossible
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Direct Construction of the Surface Mesh

MATLAB has a number of built-in commands for generating surfaces. Some of these are
cylinder (), sphere () andellipsoid().

% CREATE A UNIT SPHERE
[X,Y,Z] = sphere(41);

Surfaces can be converted to triangular patches (facets and vertices) using the
surf2patch () function.

% CONVERT TO PATCH
[F,V] = surf2patch(X,Y,Z,’'triangles’);

The faces and vertices can be directly visualized using the patch () function.
% VISUALIZE FACES AND VERTICES

h = patch('faces',F, 'vertices', V) ;
set (h, 'FaceColor', [0.5 0.5 0.8], 'EdgeColoxr', 'k') ;

S EMPossible
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Grid = Surface Mesh

3D objects on a grid can be converted to a surface mesh using the command
isosurface ().

% CREATE ELLIPTICAL OBJECT

OBJ = (X/rx)."2 + (Y/ry)."2 + (Z/rz)."2;
OBJ = (OBJ < 1);

% CREATE SURFACE MESH

[F,V] = isosurface(X,Y,Z,0BJ,0.5);

‘ Object on 3D Grid > Surface Mesh

S EMPossible
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May Need isocaps ()

When 3D objects extend to the edge of the grid, you may need to use i socaps () in
addition to isosurface ().

isosurface () isocaps () 1S?surface()
+ 1socaps ()
05 05 ] 05
0 0 ' ‘ . 0
e 05
5 05 0 05
08 0 05 05 05 0 05 -05 05 0 o505

% CREATE SURFACE MESH
[F,V] isosurface(X,Y,Z,0BJ,0.5);
[F2,V2] isocaps(X,Y,Z,0BJ,0.5);

33

S EMPossible
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Combining Faces and Vertices from Two Objects

There are no built-in functions in MATLAB to perform Boolean operations on multiple meshes. It is possible,
however, to combine the faces and vertices from two objects. Be careful that this does not result in overlaps

or gaps between objects.

Correctly Incorrectly
Fland V1 F2and V2 Combined Combined

% COMBINE FACES AND VERTICES © WRONG WAY TO
F3 = [ F1 ; F2+length(v1 (:,1)) 1 % COMBINE FACES AND VERTICES
- . F3 = [ F1 ; F2 ]
V3 = [ V1 ; V2 ] Vi o [ VL, vzl
S EMPossible 3
34
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Converting
Surface Meshes
to Objects on a

3D Grid

Slide 35

35
Example — Pyramid
o ER ( ny,nz)
SolidWorks Model
B
ol ”
‘ |
"ﬁ' EMPossible Import STL into MATLAB Convert to Volume Object
36

4/25/2025
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Example — Dinosaur

ER (nx,ny,nz)

Import STL into MATLAB Convert to Volume Object

S EMPossible 37
37
MATLAB Functions for “Voxelization” of STL Files
The Mathworks website has excellent functions for converting surface
meshes to points on a 3D array.
Function for Voxelization
http://www.mathworks.com/matlabcentral/fileexchange/27390-
mesh-voxelisation
S EMPossible 38
38
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Converting
Images and 2D

Objects to STL

39

Load and Resize the Image

% LOAD IMAGE
B = imread(‘'letter.jpg');

% RESIZE IMAGE
B = imresize(B,0.2);
[Nx,Ny,Nc] = size(B);

This will give a coarser mesh in order to
be faster and more memory efficient.

S EMPossible
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Flatten the Image

Images loaded from file usually contain RGB information making
them 3D arrays. These arrays must be converted to flat 2D arrays
before meshing.

o\°

FLATTEN COLOR IMAGE

0.3

B = double (B) ;
o B =DB(:,:,1) + B(:,:,2) + B(:,:,3);
o4 B =1 - B/765;

S EMPossible 2
41
. Mesh the image using isocaps (), but that function requires

a 3D array. So, stack this image to be two layers thick.

% STACK IMAGE

B(:,:,2) = B;

i,
s

S EMPossible PP
42
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Mesh the

3 A
N
Lo
- SR
e anawe

Image Using isocaps ()

S

RSEPEARILLIDS

52
B,
R .
KA LI TIT T
RREARB 5T
LG

o - It is only desired to mesh a single surface sogive isocaps ()

the additional input argument ‘zmin’ to do this.

°
o

F

S EMPossible
43

CREATE 2D MESH
/V] =

7

isocaps(ya,xa, [0 1],B,0.5, 'zmin"')

43

Save this mesh as an STL file.

Save the Mesh as an STL File
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Extrude Using Blender (1 of 2)

% Blender B o [
o L1 . [

1. Open Blender.exe.
2. File = Import > Stl (.stl)
3. Open the STL file you just created.

51 EMPossible a5
45
Extrude Using Blender (2 of 2)
1. Select the object with right : e B *
mouse click.
2. Press TAB to enter Edit mode.
3. Press ‘e’ to extrude mesh.
4. Press TAB again to exit Edit mode.
5. You can now edit your object
or export as a new 3D STL file.
S EMPossible 46
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Point Clouds

Slide 47

47
Klein Bottle (see MATLAB demos) Point Cloud Description of a Klein Bottle
Point clouds represent the outside surface of object as a set of vertices defined by X, Y, and Z coordinates. They are
typically generated by 3D scanners, but can also be used to export 3D objects from MATLAB into SolidWorks or other
CAD programs.
S EMPossible a8
48
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Other Examples of Point Clouds

Draped Surface over points

51 EMPossible 49

49

Point Cloud Data

The position of all the points in the point cloud can
be stored in an array.

bo -,
R BT
IR R R T
(36 1 1 %9 AN
XN g AR YRR
35 570 el et A
IR AREBA NS 4 R,
N®, el ARSI A
X, V2 24 2 P F oent oVese
Ne s L*, s AR L SR
PC=| x z EX K ‘e
= - - ) . 4 .
T B s gyl
: T T e, Ta
A b A * ."
';'"' - -
Xy Yy Z
N Yy Zn t
PC = \
0.1200 0.0000 0.7071
0.1159  -0.0311 0.7071 N
0.0311  -0.1159 0.7071
0.0000 -0.1200 0.7071
-0.0311  -0.1159 0.7071
-0.0600  -0.1039 0.7071
.
.
.
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Point cloud data files are comma separated text files
with the extension “.xyz”

These can be easily generated using the built-in
MATLAB command csvwrite ().

% SAVE POINT CLOUD AS A COMMA SEPERATED FILE
PC=[X2ZY];

Ll A0S

S EMPossible

dlmwrite ('pointcloud.xyz',PC, 'delimiter',',', 'newline', 'pc');

Saving Point Cloud Data to File (1 of 2)

e EEOsE

i PC= [ XZY];

51

51

SolidWorks wants to see an XY Z at the start
of the file.

This can be added manually using Notepad or
by writing a more sophisticated MATLAB text
file creator.

S EMPossible

Saving Point Cloud Data to File (2 of 2)

j pointcloud2 b - Motepad
File Edit Format View Help

(= e =

Yz
12,7.3479e-018,0.70711
11963,-0.0094151,0. 70711
11852,-0.018772,0. 70711
11668, -0.028013,
114132,-0.037082,
11087, -0.045922,
10692, -0. 054479
10232,-0.0627,0
097082 ,-0. 070534,
091249,-0.077934,0
084853,-0.084853,0
077924,-0.091249,0.70711
070524, -0.097082,0. 707
0627,-0.10232,0.7
054479,-0.10692,0
045922 ,-0.11087,0
037082,-0.11413,0
028013,-0.11668,0
018772,-0.11852,0
0094151,-0.11963,
4696e-017,-0.12,0
0094151,-0.11963,0.7
.018772,-0.11852,0.
.028013,-0.11668,
.037082,-0.11413,
.045922,-0.11087,0.707
.054479,-0.10692,0.70711
.0627,-0.10232,0. 70711

=l=l=l=T==T=l=T=T=T=T= =YY= RaT=TuT=T=0"

W L
[=Y=F=-F-F-Y-1-]

-

52

52
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SolidWorks.

Click Tools=>Add-Ins.

Click OK.

First, you will need to activate the ScanTo3D in

Check the Scanto3D check box.

— 7]l scanTo3D

Activate ScanTo3D Add-In in SolidWorks

[add-ns =]

Active Add-ins [ start up|
B SolidWorks Premium Add-ins
7138 30 Instant Website

[C] & Circuitworks
DﬁFeatureWums

| Photaworks

:l'-?ﬂ, SolidWorks Design Checker
[7]&P salidworks Motion

[/ solidwarks Routing

(10 solidWarks Simulation

] solidWorks Toolbox

[7]'F salidworks Toolbox Browser
DW SolidWorks Utilities

[T Totanatyst

= SolidWorks Add-ins

[F]  Autotrace

[[]  SelidWarks Flow Simulation 2010
] SolidWorks XPS Driver

OoOo| ooooDooooEEEE
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T Drawing (v lddr)
_ OXF (“)
| RecentPlaces  *  Name DWG (*.dwg)
Adobe Photoshop Fies (psd)
| [ pointcloud ‘Adobe Husretor ies ()
4 Libraries Lib Fet Part (" <llfp)
B Documents | & Template (- pridot* asmdot;.drcot)
= Parasalid (3 b amt_o;am_bi) - =
& Music e o T x5t i) ERSolidWorks [f re eat vew et Tods wniow sip 3p.. QT ) 2 - - 1 %
Pictures STEP AP203/214 (stepi"tp) =
aw ACIS ("sat) e CoIEEYL %R (2L}
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VRML Cor) Seth smart T Convert
8 Computer STL (st omenson |E1~ 2+ & - A eres enits 2 e
¢ Catia Graphics C.cgi) -® - s dove Entes
& os ProE Part (" xpr) = XA A L
9 rcrumpf (\engsr Prof Acsembly (“asm.asm. " as) Features | sketch [[Evaluate | DimXpert | Ofice Products - B x
S faculystaft (en Inventor Part (%pt) Y (el -3ED » AR
2 SolidWorks 2010 Inventor Assembly (“iam) C—
5 emlab (\\engrfile Solid Edge Part (*.par;”.psm) R Partd (Default<<Defauit> _Disg] @
Soli Edge Assembly (ssm) B3] Sencers (@
CADKEY (~prt:.ckd) b &
€ Network v I Add-Ins (ll) (Al /Aanctations =)
31y IOF Cmnbrct bt i) $2 Matel <not seciied> o
P Rhino (~3dm) B Emime =
o D Mesh Fills(*. X Top Plane )
onfigurations  +
oo X Right Plane @
Fle name: *XYZ~TXT" ASCF VOAMIGS 8L~ 3% Point Cloud k| &
y
N
+| “tzometric
T
Education Editon - Instructional Use Orly Edtngpar [ <)
S EMPossible sa

54

4/25/2025

27



Run the Mesh Prep Wizard

Tools>ScanTo3D->Mesh Prep Wizard...

1. Run the Mesh Prep Wizard.
2. Select the point cloud.
T P ———— Y T 3. Click the right array button. &
SZAZEEbLERE, 4. Orientation method, select None
pe == - | e e, because we did this in MATLAB.
) o I — 5. Noise removal, zero assuming
=TT AAENE T80 geometry came from MATLAB.
SRRl a 6. Work through all options.
s> s 7. Click the green check mark to finish.
3 Right Plane:
P ] 5
Editing Part 2]

51 EMPossible 55
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Point Cloud Density

S EMPossible 56
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Final Notes on Point Clouds

* Other CAD packages have better point cloud import
capabilities than SolidWorks. Rhino 3D is said to be
excellent.

* Generating a solid model from the data can be done
in SolidWorks. The meshed model is essentially used
as a template for creating the solid model. This
procedure is beyond the scope of this lecture.

S EMPossible
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Importing
Custom
Polygons into
SolidWorks
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The Problem

Suppose the vertices of a polygon are calculated from some sort of
optimization in MATLAB.

. . HFigure1 =R E=E <
How can the vertices be imported e Gt Yo bom Joos Dy Moty -

) . VEHS | KRGO LRL- (S| 08| 0D
into SolidWorks so that the polygon

is exact in order to be extruded,
cut, modified, etc.?

There is no feature in
SolidWorks to do this!!

S EMPossible 59
59

Example Application

Placing a GMR filter onto Grating period is spatially
a curved surface. varied to compensate.

X 4 sin(x/R)
O (x) = ¥tan L+d/R—cos(x/R)}
Sgurce K (x)= K, ~ kg, sin[6,,(x) ]
d)(x):jl((x')dx'
g’_(x)={1 cos[tb(x)]<cos(7rf)

& cos[lb(x)] 2cos(zf)

A =5.49 mm A =5.49 mm

A=9.19 mm

R. C. Rumpf, M. Gates, C. L. Kozikowski, W. A. Davis,
"Guided-Mode Resonance Filter Compensated to Operate
on a Curved Surface," PIER C, Vol. 40, pp. 93-103, 2013.

< EMPossible : 60
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Point

Reference | Qurves %
s Instant3d
Curve Through XVZ Points
@ @, % ‘2f urve Throug| cints
and Spiral
Curve File
C\Users\reru

mpfDocuments\COURSES\EM21 -
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B
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Be Careful About XYZ Curves

There is a feature in SolidWorks “Curve Through XYZ Points” that appears to import
discrete points, but it fits the points to a spline. This effectively rounds any corners and
may produce intersections that cannot be rendered.

This should be a square!
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The four points are fit to a spline!
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Create an Nx3 array in memory which contains all of the points around the perimeter of
the polygon. N is the number of points.
P - Brouret ==
0.6448 0 0 File Edit View Inset Tools Desktop Window Help kT
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20.9966 0.1664 0 oe
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-1.1762  -1.2777 0 os
-0.5403 -1.2314 0
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Step 2 — Save as an IGES from MATLAB

There is a function called igesout () available for free download from the
Mathworks website. This will save your polygon to an IGES file.

% SAVE IGES FILE
igesout (P, 'poly') ;

This creates a file called “poly.igs” in your working directory.

S EMPossible 63
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Step 3 — Open the IGES in SolidWorks (1 of 2)

Select the IGES file type in the [Open] file dialog. Then click on the [Options...] button.

B Open
\J\; [ < EM21 - Spring 2... » MATLAB Codes

Organize v New folder

¢ Favorites
B Desktop [ polyigs
& Downloads

| RecentPlaces |

4 Libraries

[ Documents
usic
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Step 3 — Open the IGES in SolidWorks (2 of 2)

Import Options

(et |
1. Make sure that “Surface/solid
entities” is unchecked
2.Ensure that “Free point/curve
entities” is checked. E———
3. Click on the “Import as sketch(es) DU““‘”““
radio button. b anbedend
IGE Show IGES levels.
Open the file. T
UGD Import tool bodies.
=)
Concel b
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Step 4 — Convert to a Standard 2D Sketch
The polygon imports as a 3D sketch by default.
Edit the 3D sketch and copy.
Open a new 2D sketch and paste.
Now it is possible to do whatever is needed to the sketch! Extrude, revolve, cut extrude,
etc.
i i
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STL to CAD
Conversion

Slide 67

67
Import STL Into MeshlLab
1. Open meshlab.exe.
2. File 2 Import Mesh
3. Open the 3D STL file you just created.
ﬁn EMPossible 68
68
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Convert to SolidWorks Part

Open meshlab.exe.

Select DXF file.

Select ‘Import to a new part as:’
then ‘3D curves or model’

then ‘Next >/

9. Select ‘All Layers’

1.

2. File = Export Mesh As - a we
3. Select DXF file type. ‘—‘—‘—“",—_7(: —_— S
4. Save mesh.

5. Launch SolidWorks. B 15

6. File > Open

7.

8.

P BT

=,

oo SuaT
[Soldvorks Education Edtion - Instructions Use Only Editing Part ves_ - @
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Exporting STL
from Blender with
Proper Units

Slide 70

70
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51 EMPossible

. Set units in Blender
2. Resize appropriately

. Save and make sure

. Sizes will automatically

Properly Sizing STL Files in Blender

(units will be rescaled
to millimeters by slicer)

scene unit is selected

rescale to millimeters

71

71
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